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END USER LICENSE AGREEMENT (For U.S. customers only)

IMPORTANT - CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS 
OF THIS AGREEMENT.

This End User License Agreement (“Agreement”) is a legal agreement between you, the user of 
Philips’ portable computing device (“Product”), and Philips Mobile Computing Group (“Philips”), 
the manufacturer of the Product. The Product comes with certain software, and associated 
documentation, which are installed on the Product and/or included in the original Product 
packaging on external media. (All such software and documentation, but specifically excluding 
Microsoft software and documentation, are collectively referred to as “Software”.) YOU DO 
NOT NEED TO SIGN THIS AGREEMENT IN ORDER FOR IT TO TAKE EFFECT. BY 
INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE, YOU ARE AGREEING 
TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS AGREEMENT, PHILIPS IS UNWILLING TO LICENSE THE USE OF THE 
SOFTWARE TO YOU. IN SUCH EVENT, YOU MUST NOT OPEN THE SEALED PRODUCT OR 
SOFTWARE, AND MUST PROMPTLY RETURN THE SEALED PRODUCT AND SOFTWARE 
TO THE PLACE YOU OBTAINED IT FOR A FULL REFUND.

1. Grant of License. Philips hereby grants you the non-exclusive right to use the Software 
only as installed on the Product or, for Software which is not already installed on the 
Product, to install and use the Software on a single Product.

2. Ownership of the Software and Documentation. You do not receive title or 
ownership to the Software, but merely the limited right to use the Software as specified in 
this Agreement.

3. Restrictions. You may not: (i) copy the Software except for one copy for back-up archival 
purposes provided that the copy contains all of the original Software’s proprietary notices 
and is subject to all of the terms of this Agreement; (ii) modify, translate, reverse engineer, 
decompile, disassemble (except to the extent that this restriction is expressly prohibited by 
law) the Software, or create derivative works based upon the Software; (iii) rent, lease, lend, 
or sublicense the Software; (iv) or transfer the Software except together with the sale or 
transfer of the Product and then only if you keep no copy of the Software, if you transfer all 
of the Software (including back-up copies), and if the recipient agrees to comply with, and be 
bound by, the terms of this Agreement.

4. Termination. This Agreement, and the licenses granted in it, is effective until terminated. 
This Agreement will terminate: (i) automatically if you fail to comply with any of the terms of 
this Agreement; or (ii) without prejudice to any other rights, upon written notice sent to you 
by Philips, if Philips, in its sole judgment, believes that the Software is being used for a 
purpose not approved by it or that its rights are being jeopardized. In such event, you must 
destroy all copies of the Software and all of its component parts immediately upon receipt of 
such notice.

5. Microsoft Software. This Agreement does not apply to Microsoft software. Your rights 
to use, and restrictions on, Microsoft software are governed by a separate end user license 
agreement, included with the Product, which applies exclusively to Microsoft software.

6. U.S. Government. Restricted Rights. Pursuant to DFARS 227.7202 and FAR 12.212, the 
Software is subject to, and restricted by, this Agreement. Use, duplication, or disclosure by 
the United States Government is governed solely by the terms and conditions contained 
herein.

7. Choice of Law. This Agreement is governed and construed under the laws of the State of 
California, except those portions pertaining to conflicts of law. You consent to the exclusive 
jurisdiction of the state and federal courts sitting in the State of California.

8. Entire Agreement. This Agreement constitutes the final, exclusive and complete 
agreement with you concerning the Software. It may not be amended or altered except in a 
written document signed by you and an authorized representative of Philips.
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Chapter 1

Welcome to the Nino™
–the premier color Palm-size PC that keeps you up-to-date when 
you’re on-the-go. 

With its unique ergonomic design, color screen, and 
automatic synchronization with your primary 
Microsoft® Windows®-based PC, your Nino lets you 
easily and quickly find or modify your essential 
personal information—including your calendar, 
tasks, contacts, e-mail, Internet Information 
Services (channels), and much more.

Utilizing the Microsoft® Windows® CE 
operating system for the Palm-size PC, the Nino 
also provides bonus software, including 
Microsoft Note Taker, Voice Recorder, 
and more. 

This guide will help you get started. 

For more detailed information, you can turn to a variety 
of resources:

■ Online help—On the Start menu, tap Help to get 
information about specific features of Nino software.

■ The Philips Nino CD—Go to this CD for documentation 
about the extra software bundled with your Nino, as well as 
other useful information.

■ The Nino Web site at http://nino.philips.com—Visit this site 
for the latest Nino news, tips, accessories, and support information. 

■ The Microsoft Windows CE Web site at
http://www.microsoft.com/windowsce/default.asp—Visit this 
site for the most recent information about Windows CE.
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A tour of the Nino

Nino front and right side

Nino left side

Indicator lights
The top light goes on when an 
alarm you’ve set is activated. The 

bottom light blinks green when the
batteries are recharging.

On/Off button 
Press this button to turn the Nino 
on or off. 

Dock/serial 
connector
Connects the Nino to 
the Nino Dock.

Telecom Port
Connect the U.S. 
Modem Click-on or 
the European modem 
cable here.

Quick Start buttons
Press one of these 
customizable buttons to 
turn the Nino on and 
start a particular 
program, or to switch 
instantly between 
programs.

AC adapter port
Plug in the Nino AC 
Adapter here.

Scroll up control
Press here to scroll 
up in a list. 

Action button
Functions like the Enter 
key on your PC.

Exit button 
Functions like the Escape key 
on your PC. 

Microphone 

Speaker

Scroll down control
Press here to scroll down 
in a list.
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Nino back

Other Nino components

Nino Dock
Place the Nino in the Nino Dock 
to synchronize information with 
your primary PC and to recharge 
the batteries.

DC Input 
jack symbol

Non-removable 
backup battery 
Maintains the integrity 
of your data.

Battery compartment
Install the rechargeable 
battery pack or AA 
batteries here.

Soft reset button
Press this recessed button to 
reset the Nino without losing 
saved information.

ROM compartment

CompactFlash card 
compartment
Install a CompactFlash 
card here.

Infrared port
(at top of unit) 
Send or receive information 
wirelessly via this port.

Stylus 
Use only the Nino stylus to 
write or tap on the screen.

Headphone jack 
(at top of unit)

Stylus slot
Holds your 
Nino stylus. 
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Chapter 2

First Steps with the Nino
This chapter contains the information you need to start using your 
Nino. It includes the following topics:

■ Installing the batteries and plugging in the Nino with the Nino 
AC Adapter

■ Turning on the Nino

■ Some useful settings

Installing the batteries and plugging in the Nino with the 
Nino AC Adapter

You can provide power to the Nino in three ways: 1) the Nino AC 
Adapter, 2) the Nino Rechargeable Battery Pack, or 3) two AA 
batteries. If connecting to AC power is not convenient and you 
would like to try out your Nino immediately, you can install AA 
batteries. (Be careful to correctly align the positive and negative 
ends.) Philips recommends that you first install the rechargeable 
battery pack and leave your Nino plugged in overnight.

C A U T I O N  Be aware that data you enter may not be properly 

maintained until the built-in backup battery is adequately charged. 

To install the batteries and plug in the Nino:

1 Open the door of the battery compartment.

2 Align the battery pack with the battery compartment, as shown in the 
next figure.
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3 Place the back edge of the rechargeable battery pack against the far 
wall of the battery compartment.

4 Gently roll the front end of the battery pack down into the battery 
compartment, as shown below.

5 Close the battery compartment door.

6 Plug in the Nino with the Nino AC Adapter.

Only use the AC adapter provided with the Nino.
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The green indicator light blinks while the rechargeable battery pack 
is charging. Leave the Nino plugged in for several hours (overnight 
is best). The indicator light goes off when the rechargeable battery 
pack is fully charged.

Turning on the Nino

1 Press the On/Off button once.

The Nino Welcome screen appears. In a moment, it is replaced by 
the Windows CE Welcome screen. 

N O T E  You may get a message indicating that the built-in 

backup battery is low. Be aware that it may take a few days of normal 

usage before the backup battery is fully recharged. (It recharges 

when you are plugged in to AC power, or when you are running the 

Nino using the rechargeable battery pack or AA batteries.) 

2 You may want to adjust screen contrast. 

Hold down the Exit button, and use the 
Scroll up or Scroll down control. 
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3 Press the Action button.

Nino now asks you to calibrate the unit by 
tapping a sequence of screen locations. Tap 
gently but firmly. When you have completed 
a series of taps, you’ll be asked to press the 
Action button again.

4 Set your home location.

Tap the location arrow to see a list of cities. Choose your location 
(or one nearby, for the moment). Then tap OK.

Location arrow
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5 Then set the time, using the on-screen keyboard. 

To get a colon (:), tap the Shift key.

6 Then set the date. 

Tap the date arrow to display a calendar. Navigate to the correct 
month and tap on the correct day. Then tap OK. 

A message tells you, “Setup is complete.”

Date arrow
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7 Tap once to go to the Active Desktop.

The Active Desktop can display important information such as 
your appointments and tasks for the day. Notice that your owner 
information is not yet available. It’s a good idea to provide it now.

8 Tap Tap here to set Owner information.

Use the on-screen keyboard to fill in your personal information. 
Scroll down to see all the fields available. When you’re finished, 
tap OK.

Your personal information now appears on the Active Desktop.

Any time you want to display 
the Active Desktop, tap here. 

You can make the keyboard 
disappear and reappear by 
tapping here.
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Some useful settings

To check the state of the built-in backup battery—Tap 
Start, Settings, and then Power.

To modify the contents of the Active Desktop—Tap Start, 
Settings, Display, and then the Desktop tab.

To customize the Start menu—Tap Start, Settings, Taskbar, 
and then the Start Menu Items tab.

To set one or more alarms—Tap Start, Settings, World Clock, 
and then the Alarms tab. 

To set time, date, and number formats for your country—
Tap Start, Settings, and then Regional Settings. 

To adjust backlighting—Tap Start, Settings, Backlight and 
Contrast, and then the Backlight tab. 

To adjust the contrast level on your screen—Press and hold 
the Exit button, and then use the Scroll up and/or Scroll down 
control. Alternately, tap Start, Settings, Backlight and Contrast, 
and then the Contrast tab. 
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Chapter 3

Connecting and Synchronizing
This chapter contains the information you need to create a 
partnership between your Nino and PC using Microsoft 
Windows CE Services. It includes the following topics:

■ Overview of Microsoft Windows CE Services

■ Connecting your Nino to your PC

■ Installing Microsoft Windows CE Services

W I N D O W S  N T  O N L Y To install Microsoft 

Windows CE Services on a Windows NT Workstation, use the 

procedure found in Appendix B, “Additional Windows NT 

Instructions.”

■ More about synchronization

■ Working with channels

■ Getting help on Microsoft Windows CE Services

Overview of Microsoft Windows CE Services

Microsoft Windows CE Services with ActiveSyncTM allows you to 
synchronize the information on your primary PC with the 
information on your Nino. Synchronization is the process of 
comparing the data on your Nino with your primary PC and updating 
both computers with the most recent information. For example:

■ Keep Pocket Outlook data up-to-date by synchronizing your 
Nino with your choice of Microsoft Outlook (Inbox 
synchronization with Outlook Express is not currently 
supported), Microsoft Schedule+, or Microsoft Exchange on 
your primary PC. 

■ Synchronize Voice Recorder and Note Taker documents between 
your Nino and primary PC. 

With Microsoft Windows CE Services, you can also:

■ Back up and restore your Nino data.

■ Add and remove programs on your Nino.

■ Copy (rather than synchronize) files between your Nino and 
your primary PC, and browse your Nino from your primary PC.
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Connecting your Nino to your PC

Before you synchronize your primary PC with your Nino, you have 
to physically connect the two computers.

To connect your Nino to your PC:

1 Place the Nino in the Nino Dock.

2 Connect the AC adapter to the dock, and plug it in, as shown in the 
next figure. 

3 Connect the dock serial cable to an available serial port on your PC.

4 Make sure the Nino is on.
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Installing Microsoft Windows CE Services on your Windows 
95/98 primary PC and synchronizing for the first time

W I N D O W S  N T  O N L Y You must consult your system 

administrator to install Microsoft Windows CE Services on a primary 

PC that runs Windows NT Workstation. You must have 

“administrator” privileges. The following procedure is for Windows 

95/98 users only. If you are using a primary PC that runs Windows NT 

Workstation, use the procedure found in Appendix B, “Additional 

Windows NT Instructions.”

To prepare your PC for a “partnership” with your Nino, you need 
to install Microsoft Windows CE Services from the Microsoft 
Windows CE Services CD.

Before you start, save the work on your PC and quit all programs. 
If this is the first time you are installing Microsoft Windows CE 
Services on your PC, you may also need to use your Windows CD 
during the process. 

You may also need to change the communication speed (baud rate) 
of your Nino to match the communication speed of your primary 
PC. To change the communication speed of your Nino, tap Start, 
Settings, Communications, and then the PC Connection tab. 
Make sure the Enable direct connections to the desktop 
computer checkbox is checked. By default, the communication 
speed is 19200 Kbps, and the tab says “Serial @19200.” To change 
the communication speed, tap Change Connection. On the 
Change Connection screen that appears, select the communication 
speed from the Connect to desktop computer using list that 
matches the communication speed of your primary PC. For more 
information, see “How do I check and, if necessary, change the 
communication speeds (baud rates) on my Nino and primary PC so 
that they are the same?” in Chapter 8, “Troubleshooting.”
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To install Microsoft Windows CE Services and synchronize:

1 Insert the Microsoft Windows CE Services CD in your CD-ROM drive.

The Microsoft Windows CE Services Setup screen may appear 
automatically. If the Microsoft Windows CE Services Welcome 
screen appears, click the Install Microsoft Windows CE Services 
icon. If neither screen appears, select Run from the Start menu, 
type d:setup, where d is the name of the drive with the Microsoft 
Windows CE Services CD, and press Enter. Follow the on-screen 
directions. The Installation Wizard presents welcome and licensing 
information, and then asks you to fill in your name and company, 
and choose a setup.

2 Click the Typical option and follow the on-screen instructions. 

When you have installed the software, the Get Connected dialog 
box appears. 

3 Make sure the Nino is turned on and firmly placed in the Nino Dock. 
Then, on the Get Connected dialog box, click Start.

It takes a few moments for the software to locate your Nino and to 
configure communication settings. When the process is finished, 
the Mobile Devices window appears on your PC screen. 
16 N I N O  O W N E R ’ S  G U I D E



4 Wait a few moments until the New Partnership Wizard appears.

If Microsoft Windows CE Services fails to detect your Nino, see 
online Help on your primary PC by choosing Windows CE 
Services Help Topics on the Help menu in the Mobile Devices 
folder, or refer to Chapter 8, “Troubleshooting.” 

5 Use the New Partnership Wizard to establish the Nino-to-PC 
partnership.

Fill in the device name and description (“Nino”). Leave the 
On Connect option checked for synchronization. This will 
synchronize your Nino each time it is connected.

6 A few moments after the partnership is established, ActiveSync on 
your PC automatically starts the initial synchronization process.

Information from primary PC applications such as Microsoft 
Outlook is transferred to your Nino. 

During this process you may see a screen asking you to 
“Combine” or “Discard” information on the PC and the Nino. 
Choose Combine.
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When initial synchronization is successfully completed, your 
primary PC desktop displays the Mobile Devices window with the 
message “Connected, Up-to-date” in the lower right corner.

During installation, Microsoft Windows CE Services places a 
Mobile Devices shortcut on your desktop. (Mobile Devices also 
shows up as an entry in My Computer.)

N O T E  To disconnect the Nino from the PC, take it out of the 

Nino Dock.

More about synchronization

You can synchronize your Nino and your primary PC to make 
sure that both devices have the most up-to-date information.

Synchronization starts automatically when you put the Nino in 
the Nino Dock (if you left the Automatically synchronize upon 
connecting option checked when you established the Nino-PC 
partnership). Exactly what gets synchronized depends on the 
settings you choose from ActiveSync Options on the Tools menu 
in the Mobile Devices window. 

You can synchronize the following items:

■ Contacts, Calendar, and Tasks 
Information stored in these programs on your Nino is 
synchronized with Schedule+ or Outlook on your primary PC. 
The most recently modified information, wherever it resides, 
replaces the older information.
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■ Inbox Messages

Messages in Exchange or Outlook on your primary PC are 
copied to your Nino. Messages you created on your Nino are 
stored in your Outbox and transferred to your primary PC 
for transmission. 

■ Files
Files in NoteTaker and Voice Recorder on your Nino are 
synchronized with files in the My Documents folder 
(Windows 95), or your Personal folder (Windows NT) on 
your PC. 

■ Channel Information

The most recent information for the channels you subscribe to 
on your PC is downloaded to your Nino. 

Backing up your data

Regularly back up your Nino data on your primary PC using 
Microsoft Windows CE Services, in case information on your Nino 
is ever corrupted or lost. Connect your Nino to your primary PC, 
and then click Backup/Restore on the Tools menu in the Mobile 
Devices folder on your primary PC. Your first backup may take 
some time, depending on how much information you have on your 
Nino. Subsequent backups will be faster if you select Incremental.

Working with channels

A channel is a Web site or other Web-formatted content that is 
available for offline viewing on your Nino. Channels allow your 
primary PC to download Internet, intranet, or other Web-
formatted content to your Nino via synchronization. 

Channel content can be updated on a regular basis, such as updates 
from a news channel, or on a one-time basis, such as movie listings 
from an entertainment channel. 

Internet Explorer (version 4.0 or higher) on your primary PC 
manages channels and automatic updates. Use it on your primary 
PC to subscribe to Mobile Channels. 

For information on getting started with channels on your Nino, 
visit http://www.microsoft.com/windowsce/channels/default.asp.
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Personalizing channels

Some channels are divided into content areas. You can choose 
which content areas you want to download to your Nino. In 
Channels, tap File, then Channels, and select the channels and 
content areas you want. 

You can specify the amount of channel information that is 
transferred to your Nino. In Channels, tap View, then Options. 

Your Nino stores Channel information, and replaces older content 
with newer content. To remove a channel and all of its content, in 
Channels, tap File, then Channels, and uncheck the channel that 
you want to remove.

Synchronizing channel information

You can synchronize channel information as part of the general 
synchronization process described earlier in this chapter. In the 
Mobile Devices window of Microsoft Windows CE Services, click 
Tools, ActiveSync Options, and then select Channel Item. During 
synchronization, Microsoft Windows CE Services copies channel 
information to your Nino. 

Viewing channel content

Whenever new content is available for one of your channels, the 
Channel icon appears in the status area of the taskbar. Double-tap 
the icon to switch to Channels, or tap Start, then Channels.

To view channel content, tap an icon on the Channel bar, or tap the 
Explorer button to quickly navigate to a channel.

Getting help on Microsoft Windows CE Services

For additional setup, usage, and troubleshooting information, refer 
to Chapter 8, “Troubleshooting.” Alternately, in the Mobile 
Devices folder on your primary PC, click Help, and then Windows 
CE Services Help Topics. 
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Chapter 4

Nino Basics
The Nino provides several different methods for performing basic 
operations and entering information. This chapter includes 
information about:

■ Using the hardware buttons

■ Using the microphone

■ Using the headphone jack

■ Adjusting the volume

■ Keeping your data safe

■ Using the Active Desktop

■ Using the Start menu and taskbar

■ Using the command bar

■ Typing and writing on your Nino

■ Using a modem

■ Viewing information

■ Customizing your Nino

■ Finding information

Using the hardware buttons

Your Nino has nine hardware buttons located on the front-, left-, 
and right-side of the device—four Quick Start buttons, an On/Off 
button, an Exit button, a Scroll down control, a Scroll up control, 
and an Action button. Using various combinations of these 
buttons, you can quickly perform basic operations on the Nino. For 
a diagram of the hardware buttons, see “A tour of the Nino” in 
Chapter 1.
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Hardware button basics

The more you use your Nino, the more familiar the hardware 
buttons become. The following guidelines will get you started.

The Quick Start buttons are configurable. To assign a different 
program to a button, tap Start, Settings, Buttons, and then the 
Program tab. 

Useful button combinations

You can press and hold one button, and then press a second button 
to produce certain results. The following combinations are 
particularly useful:

Stylus calibration—Press and hold the Exit button. Then, while still 
holding the Exit button, press the Action button.

Tab—Press and hold the Action button. Then, while still holding 
the Action button, press the Scroll up control.

Back tab—Press and hold the Action button. Then, while still 
holding the Action button, press the Scroll down control.

Contrast level—Press and hold the Exit button. Then, while still 
holding the Exit button, press the Scroll up and/or Scroll down 
control to adjust the screen contrast.

One-handed operation: 
You can operate the buttons 
on the Nino with one hand, 
leaving the other hand free to 
use the stylus, or for some 
other task.

Quick Start buttons: 
If the unit is off, pressing a 
Quick Start button turns it 
on and starts a program. 
Pressing and holding a Quick 
Start button starts a program 
and creates a new item or 
entry in the program. 

First (top) button–Voice Recorder

Calendar

Contacts

Tactile dots let you identify each 
button with your fingertips.

Inbox
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Using the microphone

Position yourself about 8 inches (20 cm) away from the 
microphone when recording a voice message or giving voice 
commands. For more information about recording, see “Capturing 
ideas and thoughts with Voice Recorder,” in Chapter 5.

Using the headphone jack

The headphone jack on your Nino works much the same way as the 
headphone jacks on other familiar electronic devices. To use 
headphones with your Nino, simply plug the headphones into the 
headphone jack. (The headphone jack is located on top of the 
Nino, next to the stylus holder. For a diagram of its location, see “A 
tour of the Nino,” in Chapter 1.)

Adjusting the volume

To control the volume of the speaker or headphones, tap Start, 
Settings, Volume & Sound, and then use the slider to adjust 
the volume.

Keeping your data safe

Your Nino comes with a non-removable, built-in backup battery 
that will maintain the integrity of your data in the absence of other 
power sources. Note these important points:

■ You can check the status of the backup battery by tapping Start, 
Settings, Power, and then the Battery tab.

■ It may take a few days of normal usage before this backup battery 
is fully recharged and appears as “good” on the Battery tab. (It 
recharges when you are plugged in to AC power, or when you are 
running the Nino using AA batteries.) 

■ To prevent the backup battery from running down and failing to 
protect your data, do not leave the Nino for an extended period 
of time without AA batteries, or without a connection to 
AC power. 

■ When the AA batteries become low, replace them promptly. 
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N O T E  Regularly back up your Nino data on your PC using 

Windows CE Services in case information on your Nino is ever 

corrupted or lost. Connect your Nino to your PC, and then click 

Backup/Restore on the Tools menu in the Mobile Devices folder on 

your PC. Your first backup may take some time, depending on how 

much information you have on your Nino. Subsequent backups will 

be faster if you select Incremental.

Using the Active Desktop

You can use the Active Desktop to display important information, 
such as today’s appointments and tasks.

To select the type of information you want to display on the 
desktop, tap Start, Settings, Display, and then Display Active 
Desktop. Select the items that you want to display. 

Using the Start menu and taskbar

Use the Start menu on the taskbar to switch programs, display 
settings, find information, and view Help for the current program. 

First tap Start, then tap the item 
you want.
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On the taskbar, you can also do the following:

N O T E  You can change what you see on the Start menu and 

taskbar by tapping Start, Settings, and then Taskbar.

Using the command bar

The command bar at the top of the Nino screen includes both 
menu names and toolbar buttons. You can decide which you want 
to display.

Typing and writing on your Nino

With your Nino, you can quickly type, write, and draw in the way 
that’s most convenient for you. You can type with the keyboard, 
write using Jot Character Recognizer or another text input 
application, or write and draw directly on the screen using 
your stylus.

In Note Taker, and in notes that you attach to entries in Calendar, 
Contacts, and Tasks, you can use your stylus to write on the screen. 

First, on your Nino’s input panel, select the input method you want 
to use. Tap the Input Method arrow to see your choices. 
(Alternately, you can tap Start, Settings, Input Panel, and then the 
Input Method tab.)

Display or hide 
the input panel.

Double-tap an icon 
for more information.

Choose from a list 
of input methods.

Toggle between the 
desktop and the current 
program.

Tap to quickly show 
all menu names.

Drag horizontally to see the 
menu names you want.
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Typing with the keyboard

To type, tap the Input Method arrow and select Keyboard. 
Then, tap the keys with your stylus.

You can adjust keyboard settings to suit the way you work. Tap 
Start, Settings, and then Input Panel. Select Keyboard as the 
input method, and then tap Options. Check the Use gestures for 
Space, Backspace, Shift and Enter checkbox to turn on swipe 
shortcuts (gestures) on your keyboard. Then, you can do the 
following:

■ To insert a space, swipe across the keyboard from left to right.

■ To delete a character, swipe across the keyboard from right 
to left.

■ To enter a carriage return, swipe the keyboard from top 
to bottom.

■ To enter the character in uppercase, starting on a key, swipe up.

Characters are displayed 
as you tap them.
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Writing using Jot Character Recognizer

You can use CIC® Jot™ Character Recognizer, to write. Tap the 
Input Method arrow and select Jot Character Recognizer. When 
you write a letter in the box, Jot Character Recognizer converts your 
handwritten character to typed text that appears on the screen.

You must write some letters in a particular way for Jot Character 
Recognizer to recognize them. To see how to write letters, tap the 
Help button for an online demonstration.

Write numbers here.

Write uppercase 
letters here.Write lowercase 

letters here.

Tap to see how to 
write a character.
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N O T E  Drag your stylus across the panel horizontally from right 

to left to delete a character. Drag from left to right to type a space.

As you type or write, the Nino anticipates the word you are writing 
and displays it above the input panel. When you tap the displayed 
word, it is inserted into your text at the insertion point. The more 
you use your Nino, the more words it learns to anticipate.

To customize the suggested words, tap Start, Settings, Input Panel, 
and then the Word Completion tab.

N O T E  Full documentation of the Jot Character Recognizer 

application is available on the Philips Nino CD. Click the Manuals tab 

on the Welcome screen. 

Viewing information 

Most programs provide a list view, showing the items or files you’ve 
already created in that program. You can display the list in the 
manner that’s most helpful for you. 

■ You can sort the list in a particular column by tapping the 
column heading. 

■ In Calendar, Contacts, and Tasks, you can assign entries to 
particular categories and then filter the list to show a 
specific category. 

Tap here if this is 
the word you’re 
writing.
28 N I N O  O W N E R ’ S  G U I D E



■ In Note Taker and Voice Recorder, you can place files or 
messages in folders, and then filter the list to show only the files 
or messages in a specific folder.

Using a modem

You can use your Nino and a Nino Modem Click-on (U.S.) or a 
modem cable (Europe)to connect to:

■ An Internet Service Provider (ISP) that supports PPP or SLIP 
protocols. (For more information, consult your ISP.)

■ A corporate network through a Remote Access Server 
(RAS) connection.

■ A remote desktop/notebook computer via RAS.

■ A remote desktop/notebook computer via dial-up connection.

Some U.S. models of the Nino include the Nino Modem Click-on.

For your convenience, settings information about many 
ISPs is maintained at the Nino Web site at
http://nino.philips.com/support. For more information about 
using your modem device, refer to the Owner’s Guide that came 
with it.

Customizing your Nino

You can adjust the settings on your Nino to suit the way you work. 
Select Start and then Settings to see the settings available on 
your Nino.

You might want to adjust the following:

■ Buttons, to associate program buttons with specific programs 
and to adjust the Scroll up and Scroll down controls.

■ Owner, to enter contact information in case your Nino 
is misplaced.

■ Power, to maximize battery life. 

■ System, to adjust memory allocation between storage memory 
and program memory.

■ Password, to limit access to your Nino.

■ Volume & Sounds, to customize or turn off sounds.
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■ World Clock, to set the date and time for your location and a 
second location.

■ Backlight and Contrast, to adjust backlighting and 
screen contrast.

For information on a particular setting, you can do either of 
the following:

■ Open the setting, tap Start, and then tap Help.

■ Open the setting, and then tap and hold on the label of the item 
you want more information about.

Tap and hold to see a 
description of the item.
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Finding information

The Find feature on your Nino helps you quickly locate 
information. Tap Start and then Find. Enter the text you want to 
find, select a data type, and then tap OK to start the search.

Enter the text you 
want to find.

Narrow your search by 
selecting a data type.
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Chapter 5

First Steps with Windows CE Software
The basic set of Windows CE programs is installed on your Nino. 
This chapter includes the information you need to begin using 
these applications. It includes information about:

■ Microsoft Windows CE software

■ Starting and exiting an application

■ Using infrared communication

■ Capturing ideas and thoughts with Voice Recorder

■ Creating notes and drawings with Note Taker

■ Using Microsoft Pocket Outlook

Microsoft Windows CE software

The programs that are part of Windows CE include:

To schedule appointments, 
meetings and other events
To see recent information 
from your channels 
To maintain a list of contacts, 
friends, and colleagues
To send and receive e-mail 
messages by synchronizing with 
Exchange or Outlook on your 
primary PC

To write, sketch, and make lists
To keep track of what you 
have to do
To quickly capture your thoughts 
or other important information 
you need to reference later

Tap here to see the text menus 
in Windows CE applications.

Tap here to hide the text menus.
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Other Windows CE applications include Calculator and Solitaire. 
(You’ll find them on the Programs menu.)

N O T E  Programs that are on your Nino when you buy it are 

stored in ROM (read-only memory) and cannot be removed or lost. 

You can install additional software, which will be placed in RAM 

(random access memory).

Starting and exiting an application

You can switch to the program you want to use by selecting it on 
the Start menu (tap Start, Programs, and then the program you 
want to start), or by pressing the corresponding Quick Start button. 

You may be accustomed to exiting an application on your primary 
PC when you’re through using it. That’s not necessary on the Nino. 
The Windows CE operating system is designed to handle multiple 
programs running at the same time. However, if you do want to exit 
a program, tap Start, Settings, System, and then Task Manager. 
Select the program you want to exit and tap End Task.

Using infrared communication

You can use infrared (IR) beaming for wireless transfer of 
information between your Nino and another Nino, or any other 
Windows CE device that is IR-ready.

Some useful tips

■ Position the Nino IR port and the IR port of the other device 
so that they are lined up and within three feet (one meter) of 
each other.

■ Make sure that neither IR port is blocked.

■ Turn off fluorescent lights in the immediate area. (Some types 
of fluorescent lamps can interfere with IR communications.) 
Or, move to a location with different lighting.
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Sending and receiving

You can transfer notes, contacts, or voice recordings between 
devices when both are in the same program.

To send or receive contacts, choose the Contacts program, and 
select one or more contacts from the list. Then, tap the menu 
control in the upper left corner to show the text menus. Then, on 
the File menu, choose Send or Receive.

To send or receive a note, go to the NoteTaker program, select a 
note from the list of notes, and then, on the File menu, choose 
Send To and Infrared Recipient or Receive.

To send or receive a voice recording, go to the Voice Recorder 
program, choose a recording from the list of voice recordings, and 
then, on the File menu, choose Send To and Infrared Recipient 
or Receive.

Capturing ideas and thoughts with Voice Recorder

Quickly capture thoughts and reminders, ideas, and phone 
numbers with Voice Recorder. Use it in the way that’s most 
convenient for you—by using the hardware buttons on your Nino, 
or the buttons on your screen.

Using the hardware buttons

You can use the top Quick Start button on your Nino to record and 
play recordings one-handed, so while you’re driving, for example, 
you can keep your eyes on the road.

Tap here to see the 
text menus
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Making a recording 

Playing a recording 

Navigating 

To Do This

Record Press and hold the top Quick Start button. 
You’ll hear one beep when it’s ready to record.

Stop recording Release the top Quick Start button. You’ll hear 
two beeps when recording stops.

To Do This

Play Press the Action button.

Pause/resume Press the Action button.

Stop Press the Exit button (returns to the beginning 
of the recording).

Play all Press the Action button twice (plays all 
messages in the list).

To Do This

Rewind, while playing Press and hold the Scroll up 
control.

Scroll through the list of 
recordings

Press and quickly release the 
Scroll up or Scroll down 
control.
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Using the screen buttons

Instead of using the hardware buttons, you can tap the buttons on 
your screen to record and play your recordings. A progress bar and a 
status bar provide visual indications of the process.

N O T E  To skip part of a recording, move the slider to any place 

in the recording before you play it.

Adjusting memory

If your Nino runs out of memory while recording, you’ll hear 
several beeps and see an out-of-memory message on your screen. 
You can adjust the allocation of memory on your device by tapping 
Start, Settings, System, and then the Memory tab. If you run out 
of memory frequently, you might consider buying a CompactFlash 
card for your Nino. (For more information about CompactFlash 
cards, see Chapter 6.)

Record
Stop

Play/Pause Fast-forward
Rewind

Slider
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Choosing a recording format

Voice Recorder uses a format called Mobile Voice to compress files, 
making them 25 times smaller than the original size. This allows 
you to store more recordings, although the sound quality is less 
than optimal. For the best sound quality, choose among the 
available PCM format options. These files will be larger than those 
stored in Mobile Voice format. To switch formats, tap Tools and 
then Recording Format.

N O T E  Voice Recorder uses approximately 300 bytes per 

second for recording, using the Mobile Voice format. For example, a 

10-second note uses approximately 3K.

Your recordings are saved as .wav files, which you can transfer to 
your primary PC for playback, editing, and archiving. You will 
need software for your primary PC that can play .wav files, and 
you’ll need the same codec used to make the recording. You can 
get the Mobile Voice codec by installing Windows CE Services 
or by visiting the Microsoft Windows CE Web site at 
http://www.microsoft.com/windowsce/default.asp.

Organizing your recordings 

Your recordings are saved automatically and given the names 
Recording1, Recording2, and so on, by default. These recordings 
are listed in the Voice Recorder window. To quickly rename a 
recording, tap it to select it, tap it again, and then enter the 
new name.

You can organize your recordings by renaming them and placing 
them in folders. For example, you can create a folder called My 
Novel and place all relevant recordings in that folder. 
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If you display recordings for a particular folder in the Voice 
Recorder window, any new recordings you make while that folder is 
selected will be placed in that folder. They are given the folder name 
and an incremental number (My Novel1, My Novel2, and so on).

Creating notes and drawings with Note Taker

Note Taker with Rich Ink technology makes it easy to write, sketch, 
and make lists quickly, the way you’re used to writing on paper. 

■ To use Note Taker, tap Start, then Note Taker.
You can create a new note by tapping the New button, or you 
can tap the New arrow and tap a template to start with a note in 
which the formatting and structure are already in place.

Rename a file and place it in a folder.

Display the contents of the selected folder.

Create and delete folders.

Sort the list in a column.

Create a note.

Display a list of templates.
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Entering information

With Note Taker, you can enter information in the way that’s 
easiest for you. You can use the input panel to type using the 
keyboard, or you can write using Jot Character Recognizer, or other 
text input applications. You can also write and draw directly on 
the screen. 

When you display the input panel, you’ll see the insertion point, 
indicating where the text will be placed.

When you hide the input panel, the insertion point disappears, and 
you can write or draw anywhere on the screen.

Text appears here.

Display or hide 
the input panel.
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Writing and drawing

You can use your stylus to write and draw directly on the screen.

To create a drawing, on your first stroke, cross three ruled lines. A 
drawing box appears. Subsequent strokes in or outside the border of 
the drawing box become part of the drawing.

N O T E  You might want to switch to full-screen display so that 

you can see as much as possible on the screen. Tap View, then Full 

Screen. Tap Restore to see the command bar again.

Editing and formatting a note

You can edit text you’ve entered using the keyboard or other input 
methods. You can also edit handwritten notes and sketches. To 
select the text or picture you want to edit, hide the input panel, tap 
the Select button, and drag your stylus over the text or drawing. 

N O T E  Instead of tapping the Select button, you can press and 

hold the Action button as you drag the stylus.

Everything within the 
drawing box becomes 
part of the drawing.

Zoom in to write; 
zoom out to view.
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Tap the Edit button to see your editing options. The options 
available depend on what you’ve selected—text, handwriting, or 
a drawing.

You can apply formatting to a selection, or you can set default 
formatting that will be applied to everything you then type, write, 
or draw.

You can also use the Space button to increase or decrease the space 
between elements on your screen. 

N O T E  Instead of tapping the Space button, you can insert and 

remove space by pressing and holding the Exit button as you drag 

the stylus.

Apply formatting.

Edit button
Select button

Drag the stylus 
to make your 
selection.

Then, tap and drag to 
the right or down to 
insert space.

Tap and drag to the left 
or up to close space.

First tap the Space button.
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Saving your notes

When you’ve finished a note, tap OK to save it and return to your 
list of notes. Note Taker automatically names your note as follows. 

■ The first 21 characters of the first line of typed text are used as 
the note name.

■ If no text is included in the note, but the note has been assigned 
to a folder, the notes are given the folder name and an 
incremental number (Tradeshow1, Tradeshow2, and so on).

■ If no text is included and no folder is assigned, the notes are 
named Note1, Note2, and so on.

To name a note yourself, to place it in a folder, or to change the file 
format, tap File and then Save As.

Each note in Note Taker is a file. Note Taker files are saved in Note 
Taker (.pwi) format, which synchronizes with Microsoft Word files. 
You have two additional choices for file formats:

■ To import the file into a program that supports rich text, save the 
note in Rich text format (.rtf). Handwritten words and 
drawings will be lost.

■ To import the file into a program that does not support rich text, 
save the note as a Text only note (.txt). Handwritten words and 
drawings, and all formatting, will be lost.

Change the file format.

Place the note in a folder.
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Organizing your notes

You can keep track of your notes by renaming them and placing 
them in folders. For example, you can create a folder called My 
Novel and place all relevant notes in that folder. All the notes in the 
selected folder appear in the list view.

Using Microsoft Pocket Outlook 

The Microsoft Pocket Outlook program includes Calendar, 
Contacts, Inbox, and Tasks. Using Windows CE Services, you can 
synchronize information in Microsoft Outlook, Microsoft 
Schedule+, or Microsoft Exchange on your primary PC with your 
Nino. Each time you synchronize, Windows CE Services compares 
the changes you made on your Nino and primary PC and updates 
both computers. (For more information about synchronizing, see 
Chapter 3.)

Calendar, Contacts, and Tasks have a card view and a list view. The 
card view is where you enter or view the details for each entry. The 
list view is where you view all entries. 

You can switch to these programs at any time by tapping them on 
the Start menu.

N O T E  More information on the procedures described here, as 

well as information on additional procedures, can be found in online 

Help on the Nino. Tap Start, Help, and then the item for which you 

want more information.

Notes saved in this folder 
are displayed in the list.

Name based on the first 
typed text in the note

Name based on a template

Default name for handwritten 
note, based on folder name
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Using Calendar to schedule meetings and appointments

Use Calendar to schedule appointments, meetings, and other 
events. Check your appointments in one of several views (Day, 
Week, Month, Year, and Agenda). Switch among the views by 
tapping the corresponding command bar button.

N O T E  You can display today’s appointments on your Active 

Desktop. Tap Start, Settings, Display, Display Active Desktop, and 

then select Appointments.

Tap to display/hide 
more information.

Tap when selected to 
edit the description.

Double-tap to display 
the appointment card.

Create an appointment. Agenda view
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Enter the details for an appointment on the appointment card. 

N O T E  You can quickly display a new appointment card by 

pressing and holding the Calendar program button.

If you need to schedule a meeting with people who use Outlook, 
Pocket Outlook, or Schedule+, you can use Calendar to schedule 
the meeting. When attendees receive a meeting request, they can 
accept or decline the meeting. If they accept, the meeting is 
automatically added to their schedule. In addition, their response is 
automatically sent back to you, and Pocket Update updates the 
calendar on your Nino the next time you synchronize with your 
primary PC.

Before you can send a meeting request, you will need to enter 
e-mail addresses in Contacts and set up Inbox to send and receive 
messages. For information on using Contacts and Inbox, see “Using 
Contacts to track friends and colleagues” and “Using Inbox to send 
and receive e-mail messages,” later in this section.

Save information.

Enter a date, or tap to 
choose a date from 
the Date Navigator.

Create a meeting.
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To create a meeting request:

1 Tap Tools, Options, and then select Windows CE Inbox Services. 

2 Tap File and then Make Meeting.

3 Enter the meeting information.

4 Select the contacts you want to invite.

5 Select other desired options and then OK.

Inbox automatically creates a meeting request and sends it to the 
attendees the next time you synchronize with your PC.

N O T E  Your Nino will remind you about your appointments and 

meetings by sounding an alarm, flashing the notification light, or 

displaying a message on the screen. To change how you are notified, 

tap Tools and then Options. Tap the Alarm button and then 

Reminder Options.

Using Contacts to track friends and colleagues

Contacts maintains a list of your friends and colleagues so that you 
can easily find the information you’re looking for, whether you’re at 
home or on the road. Using the IR port, you can also quickly share 
Contacts information with other Windows CE-based mobile 
device users.

N O T E  You can quickly create a contact card by pressing and 

holding the Contacts program button.

Create a contact.

Tap and enter a name 
to find it in the list.

Double-tap to display the 
contact card. Tap to view 
information in the 
preview panel.
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Enter the details for a contact on the contact card. You can enter 
both business and personal information.

N O T E  To change the type of information that appears in your 

list, tap Tools and then Customize Columns.

Using Tasks to keep a “to do” list

Use Tasks to keep track of what you have to do. Overdue tasks are 
displayed in bold.

E-mail addresses 
appear in the 
Address Book in 
Inbox.

Enter information in 
more fields.

Categories

Personal

Business

Filter the list 
by category.

Double-tap to display 
the task card.
Tap when selected to 
edit the description.

Indicates high priority.
Marked completed.
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Enter the details for a task on the task card. You can assign a task to 
a category, and if you associate a date with a task, you can set a 
reminder for it. 

All active tasks (tasks that have a start date before the current date 
and are not marked completed) are displayed in the Active Tasks 
box in the Agenda view of Calendar. 

Using Inbox to send and receive e-mail messages

Use Inbox to send and receive e-mail messages in either of 
these ways: 

■ Synchronize messages with Microsoft Exchange or Microsoft 
Outlook on your primary PC. Or transfer individual messages 
using Windows CE Inbox Transfer.

■ Send and receive messages using a dial-up connection to an ISP 
or a network. For more information about connecting to an ISP 
or a network, see the Owner’s Guide that came with your 
modem device.

N O T E  Sending and receiving messages using a dial-up 

connection requires a modem device. Some U.S. models of the Nino 

include the Nino Modem Click-on. For more information, see “Using 

a modem” in Chapter 4.

Show the
category list.

Set a reminder
for tasks with a

start date.
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Synchronizing messages

E-mail messages can be synchronized as part of the general 
synchronization process described in Chapter 3. During 
synchronization:

■ Messages are copied from the Inbox folder of Exchange or 
Outlook on your primary PC to the Inbox folder on your Nino. 
The messages on the two computers are linked, so when you 
delete a message on your Nino, it’s deleted from your primary 
PC the next time you synchronize.

■ Messages in the Outbox folder on your Nino are transferred to 
Exchange or Outlook, and then sent from those programs.

Features available on your primary PC, such as scheduling meetings 
and selective downloading of file attachments, are also available on 
your Nino.

By default, e-mail synchronization is turned off. To turn on e-mail 
synchronization, in the Mobile Devices window on your primary 
PC, click Tools, ActiveSync Options, select Message, and then 
click OK.

Click to set synchronization options.

Click to 
synchronize.
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N O T E  After you’ve selected Enable Synchronization, you can 

set message synchronization options by closing the dialog box and 

then reopening it. Select Message, and then click Options.

Using Windows CE Inbox Transfer

You can use Windows CE Inbox Transfer to copy or move specific 
messages between Exchange or Outlook and your Nino, and you 
can move them into folders other than the Inbox. The messages on 
the two computers will not be linked. You can modify or delete 
messages from one location without affecting the other.

To transfer messages, connect the Nino to the primary PC. In either 
Exchange or Outlook, click Tools, then Windows CE Inbox 
Transfer, and then indicate what you want to do.

Receiving messages

When you receive a message, double-tap it to open it.

When you synchronize with your primary PC, Inbox only 
downloads the first 50 lines of each new message. The original 
messages remain on the mail server on your primary PC.

Reply to or forward the message.

See a list of attachments.
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You can mark the messages that you want to retrieve in their 
entirety the next time you synchronize or connect to your mail 
service. Select the message, tap Service, and then tap Retrieve Full 
Copy. The icons in the Inbox message list give you visual 
indications of message status.

You specify your downloading preferences when you set up your 
synchronization options. You can change them at any time.

■ To change Inbox delivery options for mail synchronization, in 
the Mobile Devices window on your primary PC, select your 
Palm-size PC icon, click Tools, and then click ActiveSync 
Options. Select Message and then click Options. (For the 
Options button to be available, you must have previously turned 
on message synchronization.)

You’ll need to download a full message before you can view its 
attachments.

To process meeting requests, you’ll need to download the complete 
message, either by marking specific messages for downloading or by 
choosing to download all messages completely during the service 
setup. In addition, make sure to turn on the Meeting requests 
option during the service setup.

A meeting notice.

A message marked for retrieval

A message with an attachment

A message stored on the server.
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Sending messages

To compose a new message, tap the New Message button on the 
toolbar. You can enter an e-mail address in the To box, or you can 
select a name from the Address Book. All e-mail addresses entered 
in the e-mail fields in Contacts appear in the Address Book.

To send your message, tap File and then Send. Messages are placed 
in your Outbox folder on your Nino. They are transferred to the 
Outbox folder in Exchange or Outlook on your primary PC the 
next time you synchronize.
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Chapter 6

Adding a CompactFlash Card
You can install a CompactFlash card in your Nino. 

N O T E  If you install a CompactFlash data storage card, you can 

store some applications on the card, as well as data from certain 

applications, such as Voice Recorder and Note Taker. Please be aware 

that you cannot use a CompactFlash data storage card to store data 

from all applications that come on your Nino. 

To install a CompactFlash card:

1 Open the door to the CompactFlash card compartment on the back 
of your Nino. 

Push the door up and then flip it up. (The Nino can be on or off.)

2 Identify the connecting edge of the card. (There may be an arrow 
symbol on the card to help you do this.)
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3 Insert the CompactFlash card.

Make sure the ridge on the back edge of the card is facing up. 
This allows you to easily remove the card.

4 Close the door.

If you installed a CompactFlash data storage card, you now have the 
option of saving data to the card. In NoteTaker, for example, create 
a new note and then, on the File menu, choose Save As. Tap 
Option and then the location arrow to choose the storage card. For 
information about other kinds of CompactFlash cards, refer to the 
documentation that comes with the cards.
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Chapter 7

Taking Care of Your Nino
The following guidelines will help you get the most out of your 
Nino 500. Follow them carefully for years of worry-free use.

General handling

Avoid dropping the Nino. Keep it away from extremes of hot or cold.

Screen care

Use only the Nino stylus to write or tap on the Nino screen. Using a 
pen or other sharply pointed object can cause damage. Protect the 
screen from scratches. For information on cleaning the screen, see 
“Cleaning and maintenance” later in this chapter.

Battery management 

Conserve battery life by taking these steps:

■ Recharge the batteries (rechargeable battery pack and non-
removable backup battery) while you’re on the road by plugging 
in the Nino with the AC adapter whenever possible.

■ Change your Nino’s default shut-off time when running on 
batteries. The default is three minutes. On the Settings menu, 
choose Power, and then the Power Off tab.

■ Adjust the backlight settings to conserve resources. Tap Start, 
Settings, Backlight and Contrast, and then the Backlight tab. 
In the “Using Battery” area, slide the slider to “dimmest.” Check 
the Dim the backlight when device is idle more than 
checkbox, and select a low number from the corresponding list. 

■ Turn off sounds you don’t need to hear. On the Settings menu, 
choose Volume & Sounds.

■ Be aware that modem devices and CompactFlash cards use more 
power. When possible, dock your Nino before you use these 
accessories.

■ If you want to use AA batteries with your Nino, Philips 
recommends that you use lithium batteries (not alkaline). While 
it’s safe to use alkaline batteries, your Nino runs optimally with 
lithium AA batteries or the rechargeable battery pack.
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Cleaning and maintenance

Clean your Nino casing with a damp, soft cloth. To clean the 
screen, turn off the unit and then use a damp cloth or a moistened 
pad designed specifically for computer monitor screens.

Erasing all your data and settings

If you want to erase all data and settings from your Nino, you 
can perform a hard reset. This will also erase any partnership 
information with your PC. (You may want to back up your Nino 
before you take this step.) To perform a hard reset, hold down the 
On/Off button and then use the end of a paper clip to press the 
recessed Soft Reset button on the back of the unit. For more 
information about the location of the Soft Reset button, see “A tour 
of the Nino” in Chapter 1.

C A U T I O N All data and settings will be permanently erased 

when you perform a hard reset. This action cannot be undone.

Avoiding electrostatic discharge

In circumstances such as low humidity and walking on synthetic 
carpets, your body may build up a charge of static electricity. It is 
a good idea to touch a metal object such as a file cabinet handle 
before you touch your Nino or the Nino Dock.

And finally…

For worry-free use of your Nino, dock it whenever you’re near your 
PC. This recharges the backup battery (if your Nino Dock is 
plugged into AC power), and synchronizes information with your 
PC. Make sure to back up your Nino often. Docking and backing 
up frequently protects your data.

To greatly improve the performance of your Nino, periodically 
perform a “soft reset.” To perform a soft reset, using the end of a 
paperclip, press the recessed Soft Reset button on the back of the 
unit. (For more information about the location of the Soft Reset 
button, see “A tour of the Nino” in Chapter 1.) Alternately, tap 
Start, Programs, and then Reset. This restarts the Nino without 
erasing any stored information. 
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Chapter 8

Troubleshooting
Before you call Philips Customer Support, please review the 
information in this chapter. If you can’t find an answer to your 
problem here, refer to online Help, the Nino Web site (http://
nino.philips.com/support), and/or the Microsoft Windows CE 
Web site (http://www.microsoft.com/windowsce/default.asp).This 
chapter includes the following information:

■ General troubleshooting

■ Connecting your Nino to your primary PC

■ Other issues

General troubleshooting

I get a screen message saying the backup battery is 
running low and I should replace it.

The rechargeable backup battery on the Nino is not removable. 
Dock the Nino or plug it in with the AC adapter in order to 
recharge the backup battery, or replace the AA batteries.

Tapping the screen doesn’t seem to work or produces 
unexpected results.

You may need to recalibrate the Nino. Hold down the Exit button, 
and then press the Action button to display the Calibration screen. 
Follow the instructions that appear on your screen.

The Nino screen is frozen and nothing happens when 
I tap the screen or press the Quick Start buttons.

Using the end of a paperclip, press the recessed Soft Reset button 
on the back of the unit. This restarts the Nino without erasing any 
stored information. For more information about the location of the 
Soft Reset button, see “A tour of the Nino” in Chapter 1.

Even after pressing the Soft Reset button, the screen 
is still frozen.

Remove the batteries. Plug in the Nino to AC power and then use 
the end of a paperclip to press the recessed Soft Reset button on the 
back of the unit. For more information about the location of the 
Soft Reset button, see “A tour of the Nino” in Chapter 1.
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My battery doesn’t last long enough.

See “Battery management” in Chapter 7.

I get a screen message saying the Nino is “Out of 
storage memory.”

Your Nino comes with a fixed amount of memory, which can be 
used for storing data or running programs. You can increase the 
amount of memory allocated for storage. Tap Start, Settings, 
System, and then the Memory tab. Move the slider to the right. If 
no additional memory is available for storage, you can exit one or 
more applications using the Task Manager tab and then move 
the slider.

I don’t like the sound quality I get when I record a voice 
memo.

If you use Voice Recorder to record a voice memo, you can choose 
a recording format that will provide the quality of sound you find 
acceptable. (The higher the quality, the more storage memory 
required for your recording.) The format that requires the least 
storage memory is Mobile Voice.

To change the recording format, tap Start, and then Voice 
Recorder. Then tap the menu display control in the upper left 
corner to show the menus. On the Tools menu, select Recording 
Format. From the Format list, select either the Mobile Voice or 
the PCM option. If you select PCM, select a level of quality 
from the Attributes list. The higher the KB/s number (kilobytes 
per second), the higher the sound quality and the higher the 
memory requirement.

Can I make a dial-up connection between my Nino and 
America Online (AOL), or Prodigy Classic?

No. At this time, Microsoft Windows CE Services does not support 
connections to AOL or Prodigy Classic. Microsoft Windows CE 
Services can only connect to an Internet Service Provider (ISP) that 
supports PPP or SLIP protocols. AOL and Prodigy Classic do not 
support PPP or SLIP protocols. For more information, see Chapter 
4, “Using a modem.”
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I need to know what version of software my Nino uses.

At some point, you may need to know what version of software 
your Nino uses (for example, if you call Philips Customer Support). 
To determine which version of Nino software you have, tap Start, 
Programs, and then VersionInfo. Version information appears.

Connecting your Nino to your primary PC

How do I check and, if necessary, change the 
communication speeds (baud rates) on my Nino and 
primary PC so that they are the same?

To check or change the communication speed (baud rate) 
of your Windows 95/98primary PC and Nino so that they 
are the same:

1 On the Nino, tap Start, Settings, Communications, and 
then the PC Connection tab. 

2 Make sure the Enable direct connections to the desktop 
computer checkbox is checked. 

3 By default, the tab says “Serial @ 19200” indicating that 
the Nino is set to communicate with your primary PC at 
19200 Kbps. To change the communication speed of your 
Nino, tap Change Connection, and select a new speed 
from the Change Connection list.

4 On your primary PC, in the Mobile Devices window, click 
File, and then Communications.

5 In the middle of the screen, there is a box called Device 
Connection Via Serial Port. This box tells you the 
communication speed of your primary PC. If the speed is 
different than the communication speed that you selected 
for your Nino in steps 1–3, you must change it.

6 To change the communication speed, on the Start menu, 
click Settings, and then Control Panel. 

7 Double-click the System icon, and then the Device 
Manager tab. 

8 Double-click the port to which the Nino is connected. The 
Properties window appears. 
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9 Click the Port Settings tab. 

10 In the Baud Rate box, select the same speed that you 
selected for your Nino in step 3, and then click OK. 

11 Click OK to close any open windows, and then save 
the changes.

12 Reboot your primary PC.

To check or change the communication speed (baud rate) 
of your Windows NT primary PC and Nino so that they are 
the same:

1 On the Nino, tap Start, Settings, Communications, and 
then the PC Connection tab. 

2 Make sure the Enable direct connections to the desktop 
computer checkbox is checked. 

3 By default, the tab says “Serial @ 19200” indicating that the 
Nino is set to communicate with your primary PC at 19200 
kbps. To change the communication speed of your Nino, 
tap Change Connection, and select a new speed from the 
Change Connection list. 

4 On your primary PC, in the Mobile Devices window, click 
File, and then Communications.

5 In the middle of the screen, there is a box called Device 
Connection Via Serial Port. This box tells you the 
communication speed of your primary PC. If the speed is 
different than the communication speed that you selected 
for your Nino in steps 1–3, you must change it. 

6 To change the communication speed, tap Start menu, click 
Settings, and then Control Panel.

7 Double-click the ports icon, and then the port to which the 
Nino is connected. 

8 In the Baud Rate box, select the same speed that you 
selected for your Nino in step 3, and then click OK. 

9 On the Start menu, click Control Panel, and then double-
click the modem icon. 
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10 On the Dial-up Networking Serial Cable between 2 PCs 
list, click the port to which the Nino is connected, and then 
click Properties. Make sure that, in the Maximum speed 
box, the speed indicated matches the speed that you selected 
for your Nino in steps 3, and for your primary PC in step 5.

11 Click OK to close any open windows, and then save 
the changes. 

12 Reboot your primary PC.

When I dock my Nino, my primary PC automatically 
attempts to connect to the Internet.

You may need to turn off the auto connect feature on Internet 
Explorer. When you dock the Nino, a network is created between 
the Nino and your primary PC. Your PC accomplishes this through 
a program called Direct Cable Connection, which is an extension of 
the Dial-up Networking Service, the same Windows 95 feature that 
allows you to connect to the Internet. The problem occurs when 
the docked Nino accesses an adapter called the Dial-up adapter. 
The browser is set to acknowledge that the Dial-up adapter is only 
used for connections to the Internet, so it opens the Internet 
connection screen. Depending on whether you have Internet 
Explorer 4.x, or Internet Explorer 3.x, there are two procedures for 
turning off the auto connect feature. Both procedures follow.

To turn off the Internet Explorer 4.x auto-dialer: 

1 Open Internet Explorer.

2 Click View, Internet Options, and then the 
Connection tab. 

3 Select Connect via LAN.

4 Reboot the primary PC. 

N O T E  Remember that after making this change to your 

Internet Explorer setup, when you want to connect to your ISP, you 

will have to do so manually using Dial-up Networking. Once you are 

connected, start Internet Explorer, and browse as normal.
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To turn off the Internet Explorer 3.x auto-dialer:

1 Open Internet Explorer.

2 Click View, Internet Options, and then the 
Connection tab. 

3 Un-check the Connect to the Internet as needed checkbox.

4 Reboot the primary PC.

N O T E  Remember that after making this change to your 

Internet Explorer setup, when you want to connect to your ISP, you 

will have to do so manually using Dial-up Networking. Once you are 

connected, start Internet Explorer, and browse as normal.

I have more than one device using a Dial-up Adapter, 
and there are conflicts.

You may need to install Microsoft Windows 95 Dial-Up 
Networking Upgrade Version 1.2.The upgrade is located on your 
Windows CE Services CD. The installation procedure follows.

Before you start, save the work on your PC and quit all programs. You 
may need to use your Windows 95 CD during the installation process.

To install Microsoft Windows 95 Dial-Up Networking 
Upgrade Version 1.2:

1 On the Windows CE Services CD, open Optional 
Components.

2 In Optional Components, open Microsoft Windows 95 Dial-
Up Networking Upgrade version 1.2.

3 To start the installation process, double-click msdun12.exe.

4 Reboot the PC, and start Windows 95.

5 If you get a message telling you to insert the Windows 95 
CD, do so. Then reboot the PC again, and start 
Windows 95. 

6 Use the New Partnership Wizard to establish the Nino-to-
PC partnership.
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Can I connect to my Nino through the infrared port on 
my Windows NT notebook computer?

No. Windows NT 4.0 does not support infrared communication.

I am having trouble connecting my Nino to my 
primary PC.

Perform the following tasks, one-by-one, until you can successfully 
connect your Nino to your primary PC:

■ Follow the cable that connects your primary PC and Nino Dock 
to the back of the primary PC. Make sure that the cable is firmly 
plugged into a 9-pin serial port. To make sure the connection is 
firm, turn the two screws on the connector clockwise to securely 
fasten the cable to the port.

■ Remove the Nino from the Nino Dock, and wait 15 seconds 
before replacing the Nino in the Nino Dock. To make sure the 
Nino is placed firmly in the Nino Dock, press the top of the 
Nino with two fingers and apply gentle pressure.

■ Remove the Nino from the Nino Dock, and perform a soft reset. 
To perform a soft reset, use a paperclip to press the recessed Soft 
Reset button on the back of the Nino. For more information 
about the location of the Soft Reset button, see “A tour of the 
Nino” in Chapter 1. Alternately, perform a soft reset by tapping 
Start, Programs, and then Reset. Once the reset is complete, 
replace the Nino firmly in the Nino Dock.

■ Make sure that your Nino is plugged into the correct serial port. 

■ Make sure that your Nino and your primary PC are both 
communicating at 19200 Kbps. To check or change the 
communication settings, see “How do I check and, if necessary, 
change the communication speeds (baud rates) of my Nino and 
primary PC so that they are the same?” earlier in this section. 

■ Close all applications on your primary PC. Open applications, 
such as proxy servers, existing modem connections, and all 
software that uses the COM port to which the Nino is 
connected, may conflict with your Nino-to-PC connection. 

■ If your primary PC runs a proxy server, make sure that it is 
configured to recognize the Nino’s IP address—192.168.55.100
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■ Perform a hard reset on your Nino. This will erase all data and 
settings from your Nino. It will also erase any partnership 
information with your PC. (You may want to back up your Nino 
before you take this step.) To perform a hard reset, hold down 
the On/Off button, and then use the end of a paper clip to press 
the recessed Soft Reset button on the back of the unit. For more 
information about the location of the Soft Reset button, see 
“A Tour of the Nino” in Chapter 1.

C A U T I O N If you perform a hard reset, all data and settings 

will be permanently erased. This action cannot be undone.

■ Check for hardware conflicts on your primary PC. Your 
Windows-based PC uses channels called IRQs. If multiple 
hardware devices attempt to use the same IRQ, conflicts can 
occur. Consult your system manufacturer or system 
administrator to resolve possible conflicts. If you find that you 
do have a hardware conflict, use the following suggestions to 
resolve it.

C A U T I O N  Do not try to resolve hardware conflicts without 

the help of your system administrator or system manufacturer.

■ If a modem is using an IRQ port that the Nino could use 
(3 or 4), move it to a different IRQ port.

■ If you use a serial mouse on a Pentium-based system, install a 
PS/2 port and mouse.

■ Uninstall and then reinstall Windows CE Services. If you are 
using Windows NT Workstation, you must also uninstall RAS.

To uninstall and reinstall Windows CE Services:

1 Click Start, Settings, and then Control Panel. 

2 Double-click the Add/Remove Programs icon. 

3 On the list of installed software, click Windows CE 
Services 2.2 (remove only), and then click the Add/
Remove button. When you are asked to remove shared files, 
click Yes to All. 
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W I N D O W S  N T  O N L Y If you are using a primary PC 

that runs Windows NT Workstation, when you are asked if you want 

to reboot your primary PC, click No. To remove RAS, click Start, 

Settings, and then Control Panel. Double-click the Network icon. On 

the Services tab, click Remote Access Service, and then Remove. 

4 Reboot your primary PC.

5 Reinstall Windows CE Services. 

Other issues

If you can’t find an answer to your problem here, from online Help, 
at the Nino Web site (http://nino.philips.com), or at the Microsoft 
Windows CE Web site (http://www.microsoft.com/windowsce/
default.asp), see Appendix A, “Technical Support, Service, 
and Repair.”
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Appendix A

Technical Support, Service, and Repair
The Nino is designed for worry-free use. However, if you get 
unexpected results from your Nino, there are several different ways 
you can get support. This chapter includes information about: 

■ Support options

■ Returning your Nino for repair or exchange

Support options

■ Online Help
On the Start menu, tap Help to get information about specific 
features of Nino software.

■ The Nino Web site at http://nino.philips.com/support

Visit this site, and use Web Assistant self-help software to solve 
common problems. While you’re there, look for the latest Nino 
news, tips, accessories, support information, and Nino FAQs.

■ The Microsoft Windows CE Web site at http://
www.microsoft.com/windowsce/default.asp

Visit this site for the most recent information about Microsoft 
Windows CE.

■ Chapter 8, “Troubleshooting,” of this guide
Chapter 8 provides general troubleshooting suggestions and 
hints for successfully connecting your Nino to your primary PC.

■ If you have questions about the extra software that came with 
your Nino (such as the Nino Bonus Software), please contact the 
software developer directly (not Philips Customer Support) for 
customer support. 
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■ If you can’t find an answer to your problem using any of the 
resources listed above, please send an e-mail to Philips Customer 
Support describing your problem. The following table lists the
e-mail address for your location:

In the unlikely event that you need to contact Philips Customer 
Support by phone, please refer to the Worldwide Support Card that 
comes with your Nino for the phone number nearest your location. 
Please have your version information on hand. (To determine 
which version of Nino software you have, tap Start, Programs, and 
then VersionInfo. Version information appears.)

Returning your Nino for repair or exchange

If a customer support representative tells you that your Nino needs 
to be sent to Philips for service, please use the following guidelines:

■ Make sure that you get a Return Material Authorization (RMA) 
number and shipping instructions from the customer support 
representative.

■ If you’re located in a country where Philips Mobile Computing 
Group (PMCG) does not officially ship the Nino, the customer 
service representative will ask you to ship the unit to the nearest 
country that provides service for your region. The customer 
support representative will supply you with this information.

■ Philips will either perform repairs on your malfunctioning unit 
or, at its option, Philips may provide you with a refurbished unit 
in exchange.

■ Philips will return the Nino to an address, which you provide, in 
the country where the unit was serviced.

N O T E  Please be aware that, due to customs and export 
considerations, PMCG does not ship the Nino outside the country 
where it is serviced. All duties, taxes, and other charges to export the 
unit to another country are the owner’s responsibility. The Philips 
service center will not accept a package that has any unpaid charges.

Your location Support e-mail address

North and 
South America

support@mobile.philips.com

Europe / Africa eurosupport@mobile.philips.com

Asia Pacific / 
Middle East

philipsap@pacific.net.sg
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Appendix B

Additional Windows NT Instructions
Due to the special security and usability features that the 
Windows NT Workstation operating system provides, your 
Nino performs differently when you use it with a primary PC that 
runs Windows NT Workstation. This appendix includes the 
following information:

■ Installing Microsoft Windows CE Services on a Windows NT 
primary PC and synchronizing for the first time

■ About infrared communication

Installing Microsoft Windows CE Services on a Windows NT 
primary PC and synchronizing for the first time

N O T E  You must consult your system administrator to install 
Microsoft Windows CE Services on a primary PC that runs Windows 
NT Workstation. You need “administrator” privileges. The following 
procedure assumes that you are the system administrator, and have a 
good working knowledge of the Windows NT Workstation 
operating system.

To prepare your PC for a “partnership” with your Nino, you need 
to install Microsoft Windows CE Services from the Microsoft 
Windows CE Services CD.

Before you start, save the work on your PC and quit all programs. 
If this is the first time you are installing Microsoft Windows CE 
Services on your PC, you may also need to use your Windows CD 
during the process.

You may also need to change the communication speed (baud rate) 
of your Nino to match the communication speed of your primary 
PC. To change the communication speed of your Nino, tap Start, 
Settings, Communications, and then the PC Connection tab. 
Make sure the Enable direct connections to the desktop 
computer checkbox is checked. By default, the communication 
speed is 19200 Kbps, and the tab says “Serial @19200.” To change 
the communication speed, tap Change Connection. On the 
Change Connection screen that appears, select the communication 
speed from the Connect to desktop computer using list that 
matches the communication speed of your primary PC. For more 
information, see “How do I check and, if necessary, change the 
communication speeds (baud rates) on my Nino and primary PC so 
that they are the same?” in Chapter 8, “Troubleshooting.”
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To install Microsoft Windows CE Services and synchronize:

1 Log on as a member of the administrator’s group.

2 Insert the Microsoft Windows CE Services CD in your CD-ROM drive.

3 Install Microsoft Service Pack 3 for NT.

Microsoft Service Pack 3 is on the Microsoft Windows CE Services 
CD. Open Optional Components, Microsoft Windows NT 
Service Pack 3, and then I386. Then, double click update.exe to 
launch the Service Pack Installation Wizard. 

4 Reboot the primary PC, and then log on as a member of the 
administrator’s group.

5 Install Microsoft Windows CE Services.

Microsoft Windows CE Services is on the Microsoft Windows CE 
Services CD. The Microsoft Windows CE Services Setup screen 
may appear automatically. If the Microsoft Windows CE Services 
Welcome screen appears, click the Install Microsoft Windows CE 
Services icon. If neither screen appears, select Run from the Start 
menu, type d:setup, where d is the name of the drive with the 
Microsoft Windows CE Services CD, and press Enter. Follow the 
directions onscreen. The Installation Wizard presents welcome and 
licensing information, and then asks you to fill in your name and 
company, and choose a setup.

6 Click the Typical option and follow the on-screen instructions. 

7 When the Microsoft Windows CE Services installation is complete, do 
not click Yes to reboot the PC. Instead, click No, and then reinstall 
Service Pack 3. If the PC asks if you want to overwrite existing files, 
click No to All.

8 Reboot the desktop PC, and then log on as a member of the 
administrator’s group.

The Get Connected dialog box appears. This may take a 
few minutes.
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9 Make sure the Nino is turned on and firmly placed in the Nino Dock. 
Then, in the Get Connected dialog box, click Start.

It takes a few moments for the software to locate your Nino and to 
configure communication settings. 

10 On the Logon window that automatically appears on the Nino, type 
your network user name and password.

11 Wait a few moments until the New Partnership Wizard appears.

The Mobile Devices window will also appear on your PC screen. If 
Microsoft Windows CE Services fails to detect your Nino, see 
online Help on your primary PC by choosing Windows CE 
Services Help Topics on the Help menu in the Mobile Devices 
folder, or refer to Chapter 8, “Troubleshooting.” 

12 Use the New Partnership Wizard to establish the Nino-to-PC 
partnership.

Fill in the device name and description (“Nino”). Leave the On 
Connect option checked for synchronization. This will synchronize 
your Nino each time it is connected.

13 A few moments after the partnership is established, ActiveSync on 
your PC automatically starts the initial synchronization process.

Information from primary PC applications such as Microsoft 
Outlook is transferred to your Nino. 

During this process you may see a screen asking you to “Combine” 
or “Discard” information on the PC and the Nino. Choose 
Combine.

When initial synchronization is successfully completed, your 
primary PC desktop displays the Mobile Devices window with the 
message “Connected, Up-to-date” in the lower right corner.

During installation, Microsoft Windows CE Services places a 
Mobile Devices shortcut on your desktop. (Mobile Devices also 
shows up as an entry in My Computer.)

About infrared communication

Please be aware that Windows NT 4.0 does not support infrared 
communication, so you cannot connect to your Nino through the 
infrared port on your Windows NT notebook computer.
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Appendix C

Nino 500 Specifications

Processor ■ 32-bit MIPS-based RISC processor

System memory ■ RAM – 16 MB DRAM 
■ ROM –16 MB ROM

Dimensions/weight ■ Size – approx. 134 x 87 x 20 mm (5.25" x 3.41" x .75")
■ Weight – less than 220 g (8 oz.) with batteries

Communications ■ Optional low-power 19.2-Kbps data/fax modem included with 
some models

Expansion ■ 1 CompactFlash card slot (Type 1 and II compatible)

Display ■ Transmissive Color LCD (320 x 240 pixels, 0.24 mm dot pitch), 
256 colors

■ White CCFL Backlighting
■ Touch-screen
■ Indicator lights for Charging and Alarm/Message status

Power ■ Rechargeable NiMH battery pack, or 2 AA batteries
■ Built-in fast charger for battery pack
■ DC Power Jack
■ Backup battery (rechargeable, nonremoveable) 

Audio ■ Audio In (uni-directional microphone)
■ Windows 95/98-compatible sound compression—up to 16 

minutes recording time per each MB of free memory
■ Audio Out for .wav file playback and DTMF generation 

(auto dialing)
■ Headphone jack

System I/O ports ■ RS-232 serial up to 115 Kbps
■ IrDA infrared transceiver, supports up to 115 Kbps

User Input ■ 4 programmable Quick Start buttons
■ Rocker switch for scroll up and scroll down
■ Action and Exit buttons
■ Stylus
■ Voice

Software ■ Microsoft Windows CE for the Palm-size PC
■ Nino Bonus Software
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Appendix D

Regulatory Information

Declaration of conformity

This device complies with Part 15 of the FCC rules. Operation is 
subject to the following two conditions: (1) This device may not 
cause harmful interference; and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation.

FCC warning statement

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate 
radio frequency energy. If not installed and used in accordance with the 
instructions, it can cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a 
particular installation. Determine if the equipment does cause interference 
to radio or television reception by turning the equipment off and on. 
The user is encouraged to try to correct the interference by one or more 
of the following measures:

1. Where it can be done safely, reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected.

4. Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment. Shielded interface 
cables must be used when operating this device or the user’s authority to 
operate this equipment could be voided.

Responsible Party Name Philips Mobile Computing Group

Telephone (602) 557-7624

Product/Model Nino 
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Industry Canada Statement

This Class B device meets all requirements of the Canadian Interference-
causing equipment regulations. 

Cet appareil numérique de la Class B respecte toutes les exigences du 
règlement sur le matériel brouilleur du Canada.

VCCI Class 2 Statement
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Appendix E

Battery Warnings 
WARNING Do not mutilate, puncture, or dispose of batteries in 
fire. The batteries can burst or explode, releasing hazardous 
chemicals. Discard used batteries according to the manufacturer’s 
instructions and in accordance with your local regulations. 

Replace all batteries with only the same or equivalent type 
recommended in the user’s guide that came with your Philips 
Handheld computer. If your Handheld computer has a replaceable 
lithium battery, it can explode if it is inserted incorrectly.

VARNING Eksplosionsfara vid felaktigt batteribyte. Använd 
samma batterityp eller en ekvivalent typ som rekommenderas av 
apparattillverkaren. Kassera använt batteri enligt fabrikantens 
instruktion.

ADVARSEL! Lithiumbatteri—Eksplosionsfare ved fejlagtig 
håndtering. Udskiftning må kun ske med batteri af samme fabrikat 
og type. Levér det brugte batteri tilbage tilleverandøren.

VARIOTUS Paristo voi räjähtää, jos se on virheellisesti asennettu. 
Vaihda paristo ainoastaan valmistajan suosittelemaan tyyppiin. 
Hävitä käytetty paristo valmistajan ohjeiden mikaisesti.

ADVARSEL Eksplosjonsfare ved feilaktig skifte av batteri. Benytt 
samme batteritype eller en tilsvarende type anbefait av 
apparatfabrikanten. Brukte batterier kasseres i henhold til 
fabrikantens instruksjoner.

WAARSCHUWING! Bij dit produkt zijn batterijen geleverd.
Wanneer deze leeg zijn, moet u ze niet weggooien maar 
inleveren als KCA.
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Appendix F

Microsoft Windows CE CD Software
The Microsoft Windows CE CD that came with your Nino includes 
the following extra software. For more information, see the 
Microsoft Windows CE CD. 

■ Windows CE 2.0 Ethernet Components

■ Microsoft Expedia Pocket Streets 98

■ Microsoft Internet Explorer

■ Windows 95 Infrared Support Software

■ Microsoft Windows 95 Dial-up Networking Upgrade Version 1.2

■ Microsoft Windows NT Service Pack 3

■ Microsoft Exchange Update

■ Microsoft Schedule + Version 7.0a
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Index
A
AC adapter 5

diagram 6
port 2
using 5

AC adapter port 2
Action button 2
Active Desktop 10

modifying 11
ActiveSync 13

options 50
alarms 11

setting 11
America Online (AOL) 60

B
backlighting 11, 57
backup battery

See batteries, backup battery
batteries 5

backup battery 11
checking status 11, 23
maintaining 23
recharging 23

conserving 57
installing 5
rechargeable battery pack 3, 5, 

7, 57
warnings 79

buttons 21
Action 21
Exit 2
hardware 21

diagram 21
using 21

On/Off 2
Quick Start 21

configuring 22
diagram 21

Scroll down control 21
Scroll up control 21

C
calibrating 8, 22
character recognition

See Jot Character Recognizer
CIC Jot

See Jot Character Recognizer
cleaning 58
command bar 25

diagram 25
using 25

communication 61
settings 61

CompactFlash card
installing 55

conflicts 66
hardware 66

connection 14
Nino-to-PC 14, 65
dial-up

See modem, using a
Contacts 47

using 47
contrast

See screen, contrast
customizing

Jot Character Recognizer 28
Start menu 11

D
data 13

backing up 13
erasing 58
protecting
restoring 13
sorting 28
viewing 28

date 9
setting 9
setting format 11

diagram 2
AC adapter 6
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battery compartment 5
command bar 25
front side 2
Nino Dock 3
Quick Start buttons 21
right side 2
Start menu 24
taskbar 25

dial-up adapter 64
upgrade 64

dial-up connection
See modem, using a

dock
See Nino Dock

E
electrostatic discharge 58

avoiding 58
e-mail messages 50

receiving 51
sending 53
synchronizing 50

erasing 58
data 58
settings 58

erasing data
See data, erasing

Exit button 2
expansion

See CompactFlash card

F
files 13

copying 13
listing 28
sorting 28
viewing 28

finding information 31

G
getting started 5

H
hardware buttons

See buttons, hardware
hardware conflicts 66
help 1, 69

online 1
troubleshooting 59

home location 8
setting 8

I
Inbox 49

using 49
infrared communication 34

using 34
input methods

typing with the keyboard 26
writing using Jot Character 

Recognizer 27

J
Jot Character Recognizer 27

customizing 28
diagram 27
online demonstration 27
references 27

K
keyboard 25

adjusting settings 26
diagram 26
shortcuts 26
typing with stylus 26

L
lights, indicator

See indicator lights
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M
maintenance 57

batteries 57
cleaning 58
screen 57

memory 37
adjusting 37
increasing storage 60

microphone 2
Microsoft Pocket Outlook 44

using 44
Microsoft Windows CE 33

using programs 33
Web site 1

Microsoft Windows CE Services 20
help 20
reinstalling 66
uninstalling 66

Mobile Voice
See Voice Recorder

modem 29
America Online (AOL) 60
Prodigy Classic 60
turning off Internet auto-dialer 

63
using a 29, 60

modem cable
See modem

N
Nino Dock 3, 58

diagram 3
Nino Modem Click-on

See modem
Nino Web site 1
Note Taker 39

using 39
numbers 11

setting format 11

O
On/Off button 2

one-hand operation 21
online help 1
on-screen keyboard

See keyboard
overview 1

diagram 2
owner information 10

setting 10

P
PCM

See Voice Recorder
Philips Nino CD 1
Prodigy Classic 60
programs 34

diagram 34
overview 34
switching between 34
using 33, 34
version information 61

protecting data 23

Q
Quick Start buttons

See buttons, Quick Start

R
RAM 34
rechargeable battery pack

See batteries, rechargeable 
battery pack

recording
See Voice Recorder

regulatory information 77
reset 59

hard 58, 66
soft 58, 59

resources 1
getting support 69
guidelines for returning Nino 70
support e-mail addresses 70
Worldwide Support Card 70

ROM 34
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S
screen 57

contrast 7
adjusting 7

maintenance 57
Scroll down control 2
Scroll up control 2
settings 11

Active Desktop 11
alarms 11
backup battery 11
communication 61
date 9
date format 11
erasing 58
home location 8
keyboard 26
number format 11
owner information 10
screen contrast 7
Start menu 11
time 9
time format 11
viewing 30

shortcuts 26
keyboard 26

shut-off time 57
software

See programs
sounds 23

improving quality of 60
turning off 57

specifications 75
Start menu 11

customizing 11
diagram 24
using 24

stylus 22
calibrating 22

support
See resources

synchronizing 13

e-mail messages 50

T
tabbing 22
taskbar 25

diagram 25
using 25

Tasks 48
using 48

time 9
setting 9
setting format 11

tour 2
troubleshooting 59, 69
turning on/off 7

V
version information 61
viewing information 28
Voice Recorder 35

changing recording format 60
memory 37
Mobile Voice 60
PCM 60
using 35

volume 23

W
Web sites 1

Microsoft Windows CE 1
Nino 1

Windows 95 63
communication settings 61
dial-up adapter 63

Windows 98 61
communication settings 61

Windows NT 13
communication settings 62
installing Windows CE Services 

71
Nino-to-PC connection 71
special instructions 71
using infrared port 65, 73
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